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Manuals 

Purchasing policies and procedures should be followed in conjunction with ALL State of 
Texas statutes, policies and procedures.   

Additional policy & procedures include, but are not limited to Midwestern State 
University Policy & Procedures, Midwestern State University Fiscal Policy & Procedures, 
Midwestern State University Purchasing Manual and the Midwestern State University 
Procurement Card Guide.  These manuals can be found on the MSU Purchasing 
homepage. 

Please Note: 
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What is a purchase requisition? 

A purchase requisition is an internal document used to “request” the purchase of goods or 
services by the Purchasing Department.  It documents the following: 

• Who placed the order (end-user & department)
• The name of the vendor
• What you are wanting to order
• How you plan on paying for your order

The purchase requisition also documents the electronic approval by supervisors or those 
responsible for a department’s budget. 

When should I use a purchase requisition to purchase goods & services? 

• When a Direct Payment Voucher (DPV) cannot be used (See Appendix 1).
• When a potential purchase will exceed your prescribed procurement card single

purchase limit.
• When a vendor will not accept the University procurement card.
• When University policies & procedures require it.

While preliminary discussions with a vendor (by the end-user) are acceptable, the official 
purchase order and commitment of funds for the University is completed by the Purchasing 
Department.  The end-user has no authority to make a commitment before submitting a 
requisition and obtaining an authorized purchase order number.  In addition, the end-user 
must allow an adequate amount of time for the Purchasing Department to complete the 
purchasing process, depending on the type of purchase being made (i.e., developing 
specifications, soliciting formal bids, requiring on-site visits, HUB Subcontracting Plan, etc.). 

Exemptions from Bidding or Price Comparisons 

The University defines the following additional exemptions from the above bidding or price 
comparison process: 

• Classified Advertising
• Hotels and Conference Rooms
• Conference Expense; expenses related to conference room services such as

audio/visual/network and food services.  (Does not include goods purchased for
attendees or transportation services.)

• Moving Expenses (employee)
• Student Travel; expenses related to student travel
• Library materials for Midwestern State University Library, when such exemption

represents the best value to the University
• Membership Fees and Dues
• Newspaper and magazine subscriptions, books, videos and software direct from the

publisher
• Freight

SECTION 

1.0 

Purchasing Policy – When should I use a Purchase Requisition? 
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• Intra-Agency Payments
• Rental of exhibit space; i.e., booths for display purposes
• Goods and services provided by the Texas Department of Criminal Justice (TDCJ)
• Internal Repairs
• Purchases from Federal Agencies
• Utilities
• Goods and Services for an organized activity when such exemption represents the

best value to the University

Proprietary Product/Sole Source Purchases 

Proprietary Source purchasing represents the purchase of a specific item that is available 
from only one vendor who is the sole manufacturer and/or only distributor of the item.  
The end user must submit a justification explaining the need for the item and why only 
this specific item/vendor will meet the department’s needs.  See Sole Source Justification 
Form. 

Historically Underutilized Businesses (HUBs) 

Historically underutilized businesses or HUB vendors are defined as Texas businesses 
that are at least 51% owned, operated and controlled by United States citizens, born or 
naturalized and members of qualifying groups which include Asian Pacific Americans, 
Black Americans, Hispanic Americans, Native Americans and American Women. 

All state agencies and institutions of higher education are required to make a good faith 
effort to increase businesses with HUBs.  This good faith effort applies to all funds and 
all dollar amounts, including amounts that do not require bidding (including 
procurement card purchases).  Departments must attempt to use HUBs when placing 
orders under delegated authority. 

The Texas Building Procurement & Support Service (TPASS) offers the following directory 
to assist in finding HUB vendors: 

https://mycpa.cpa.state.tx.us/tpasscmblsearch/index.jsp 

Image 1.01 – TPASS Hub Directory Search 
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You can search for vendors by Vendor ID and Vendor Name.  You can also filter your 
search by commodity category or location.  The Purchasing Department is available to 
assist when searching for HUB vendors. 

Unauthorized Purchases 

An unauthorized purchase is any purchase made in a manner other than the Purchasing 
Tools described above.  Entering a requisition after the order has been placed is 
prohibited.  Unauthorized purchases present problems and create unnecessary 
paperwork for the Purchasing Department, Accounts Payable, vendors, end-users and 
supervisors.  Pre-planning is the best way to avoid an unauthorized purchase. 
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Database “Forms” are sometimes referred to as “data entry screens” and are used to control how 
end-users interact with the data contained in a database (i.e., Banner Finance System).  Forms 
can be used to protect data and to ensure the data is entered properly or can be used to query 
your database data for a particular output. 

When logging into Internet Native Banner (INB), you will navigate to a specific form using the 
“Go To” search box.  To prepare a purchase requisition you will type “FPAREQN” in the “Go To” 
search box to go directly to that form. 

Image 2.01 “Go To” Box @ Main Menu 

The following is a list of a few frequently used Banner Finance Forms you may find yourself 
navigating: 

Banner Form Purpose

FPAREQN Create Purchase Requisition

FPIREQN Query (View) Completed Purchase Requisitions

FOIDOCH Document History (View document status & all related banner documents

FGITRND Detail Transaction Activity (by Fund)

FGIENCD Detail Emcumbrance Activity (by Document)

FGIBAVL Budget Availiablity Status

FGIBDST Organization Budget Status

FOAAINP Document Approval (Approval Future)

FOIAPPH Document Approval History (Approval Past)

FOADOCU Document by User

FOAUAPP User Approval (All documents needing approval)

FPIOPOV Purchase Orders by Vendor

SECTION 

2.0 

How do I navigate Internet Native Banner (INB)? 
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When exiting a specific form use the “Exit” icon in the form tool bar. 

Image 2.02 Exiting a Form 

If you’ve navigated specific forms in your current session of INB, you can find your previously 
visited forms by clicking on the “File” tab at the main menu.   

Image 2.03 “File” Tab @ Main Menu 
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To open an additional form while navigating a specific form, you can use the “F5” Key to open a 
“Go To” search box.  Instead of navigating back to the main menu to open another form, the 
“F5” key will give direct access to another form.  Pressing “F5” again will close the search box.   

Image 2.04 “F5” Direct Access Key 

When navigating several forms you can see where you are and where you’ve been.  To return to 
your originating form, simply use the “Exit” icon to close your current form. 

Image 2.05 Banner “Bread Crumbs” 
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When navigating fields within a form, Banner will offer helpful hints in the “Help Bar” located at 
the bottom right of the screen. 

Image 2.06 Banner Help Bar 

The Options menu can also be a source for additional information depending on the form you 
are currently using. 

Image 2.07 Banner Options Menu 

Becoming familiar with the Menu/Toolbar will help you navigate within a specific form. 

Image 2.08 Banner Menu/Toolbar
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Banner Navigation Guide 

Toolbar Icon Function Menu Keystroke

Save File/Save F10

Rollback File/Rollback Shift + F7

Insert Record Record/Insert F6

Delete Record Record/Remove Shift + F6

Next Record Record/Next Down Arrow

Previous Record Record/Previous Up Arrow

Next Block Block/Next Ctrl + Page Down

Previous Block Block/Previous Ctrl + Page Up

Enter Query Query/Enter F7

Execute Query Query/Execute F8

Cancel Query Query/Cancel Ctrl + q

BDM-Display Document N/A N/A

BDM - Add Document N/A N/A

Exit File/Exit Ctrl + q

Direct Access Direct Access File/Direct Access F5

Image 2.09 Banner Navigation Guide 
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To process and complete a purchase requisition (with required backup documentation) for 
electronic approval, requisitions must be processed using Internet Native Banner (INB).  It will 
require a different username/password and log-in procedure than the one used in Banner Self-
Service.  Contact the Business Office to obtain your username/password for INB. 

“Click” on the “Banner” hyperlink in the related links section of the MSU Information Technology 
homepage.  Then “click” on the “PROD-INB” hyperlink under Banner-Production Systems and log-
in.   

Image 3.01 Banner Login Links 

Image 3.02 Banner Login Links (2) 

SECTION 

3.0 

How do I process a purchase requisition in INB? 



Banner Requisitions & Document Mgmt MSU Finance – Purchasing- 12 -

You will be directed to a page similar to the following: 

Image 3.03 – Internet Native Banner (INB) Homepage 

INB will allow you to customize your Banner pages.  From the INB homepage you can click 
File/Preferences from the menu bar and adjust the color and hyperlinks listed in the “My Links” 
section.  You can also customize your “My Banner” section of the homepage using the form 
“GUAPMNU”. 
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Image 3.11 Requestor/Delivery Information Section 

Please follow the steps listed below to start processing a purchase requisition in INB: 

Requestor/Delivery Information Section 
SECTION 

3.1 
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Image 3.21 Vendor Information Section 

The following steps will help you process the Vendor Information Section of your INB purchase 
requisition: 

Vendor Information Section 
SECTION 

3.2
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Image 3.22 Vendor Information (Vendor Search) 

Image 3.23 Vendor Information (Vendor Query) 
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Image 3.24 Vendor Information (Vender Type-Search) 

Image 3.25 Vendor Information (Scroll Vendor Addresses) 
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Image 3.31 Commodity/Accounting Section 

The Commodity/Accounting section of the requisition will be where you will most likely add 
your backup documentation.  This is because this section is where Banner assigns your 
requisition a requisition number.  Instructions for adding your backup documentation appears 
in Section 4.0 of this manual. 

Commodity/Accounting Section 
SECTION 

3.3
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Image 3.32 Adding Item/Document Text to Requisition 

Image 3.33 Adding Item/Document Text to Requisition (continued) 
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Image 3.34 Commodity Section vs. Accounting Section 
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Image 3.41 Balancing/Completion Section 

Image 3.42 Saving an Incomplete Requisition “In-Process” 

Balancing/Completion Section 
SECTION 

3.4
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Image 3.43 Form FOADOCU (Denying Your Document) 

FOADOCU will also allow you to review a list and query documents you have processed. 

Image 3.44 Form FOAAINP (Document Approval) 

If a requisition is not approved (REQ Denied) the original requisitioner will get a daily email with 
an attachment of the requisitions that have been denied along with the reason for the denial (if 
the approver gave one). 

The original requisitioner will also receive a daily list of all requisitions that been approved. 
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Image 3.45 Requisition Removal 

To delete an incomplete requisition, go to the “Requestor/Delivery Information Section and 
select “Record” from the menu bar and click on “Remove”.  In the status bar at the bottom of the 
requisition, you will be prompted to select “Record/Remove” again to make the deletion 
permanent.  Documents attached to the removed requisition should be removed from 
ApplicationXtender unless they will be assigned to a different requisition.  If so, you will have to 
modify the index associated with those documents (See Attaching Backup Documents). 
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To attach backup documentation to your requisition, you should at minimum, completed a 
purchase requisition in INB up to the “Commodity/Accounting Section” of your requisition.  
While you can add images to your requisition at any stage afterward, you at least need the 
“Document ID” (purchase requisition number) to tie your image to your Banner document. 

Image 4.01 BDM – Add Document Icon 

If you are adding images to your document for the first time, you will need to install add-ons to 
your Application Xtender Software.  First click on the “BDM-Add Document” icon to open your 
Application Xtender Software.  Next, click on the “Help” link in the application menu to “Check 
Installed Components”.    

Image 4.02 BDM -Checking Installed Components 

SECTION 

4.0 

How do I add backup documentation to my purchase requisition? 
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Image 4.03 BDM -Add-On Components List 

Once you’ve installed all required components, your install status should appear as follows: 

Image 4.04 BDM – Component Install Status 

After installing your add-on updates, you are now ready to attach images to your banner 
purchase requisition.  Close the Application Xtender tab in Internet Explorer to return to your 
INB requisition.   Click on the “BDM-Add Document” icon to proceed. 
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Image 4.11 BDM -Application Toolbar vs. Document Toolbar 

For the purpose of this training manual, the different toolbar sections associated with your 
Banner Document Management System will be identified as follows: 

Application Toolbar/Menu – Toolbar icons associated with navigating the application, 
executing and reviewing the results of a query, indexing a document, adding a batch and 
reviewing the batch list and the document index associated with a document. 

Document Toolbar - Toolbar icons associated with the actual document used to navigate from 
page to page export a page and/or used to edit pages within an indexed document. 

To attach a document to your banner requisition, you will need to be logged into Internet Native 
Banner (INB).  For optimum use, you should be logged into INB using Internet Explorer (32-Bit).  
Because you are using IE 32, you will be prompted to install JAVA updates.  DO NOT INSTALL 
JAVA UPDATES. 

It is ideal for you to attach your backup documents to your requisition prior to forwarding your 
requisition for approval.  This allows all approvers to see any important backup documentation 
required to make an informed decision regarding the approval/denial of a requisition.   

When creating your purchase requisition, the “Commodity/Accounting Section” is where you 
should get into the habit of adding your backup documentation.  Here you will be assigned the 
requisition number necessary to attach your backup documents.   

You can save your requisition by clicking on “In-Process” and attach additional documents at a 
later time, but if you are planning on completing your requisition from start to finish (with 
backup documents) the Commodity/Accounting Section is where you should access BDM. 

Attaching Backup Documentation 
SECTION 

4.1 
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Image 4.12 “BDM-Add Document” Icon in INB 

Image 4.13 BDM – New Page Icon 

Image 4.14 BDM – Page Menu 
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Image 4.15 BDM – Selecting Documents to Import 

Image 4.16 BDM – Index New Document 
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Image 4.17 BDM – Document Type & Save 

Image 4.18 BDM – Attach All Pages 
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Image 4.19 BDM – Logout Menu 

Image 4.20 BDM – Logout or Close Tab 
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Appendix 1 

Direct Payment Vouchers 

The following have been identified as items that may be presented directly to the Business Office for 
payment using a Direct Payment Voucher (DPV). These items do not involve the Purchasing Office or 
require a Purchase Order or Purchase Requisition to order from the vendor:  

a. Registration fees for conferences, seminars and workshops (These can be paid for using the 
University Procurement Card or processing a DPV). 

b. Umpire/Officials fees for referring sporting events. 
c. Memberships (These can be paid for using the University Procurement Card or processing a DPV). 
d. Overnight hotel lodging (paid on behalf of an official University guest). 
e. Fees for performers and entertainers. 
f. Business meal reimbursements. 
g. Fees for Guest Lecturers. 
h. Subscriptions and Periodicals (unless a Purchase Order is required - may also be purchased using 

the University Procurement Card). 
i. Filing fees for work to be performed on buildings (i.e., Texas Department of Health). 
j. Professional registration/license fees (excluding software licenses). 
k. Postmaster-Permit, bulk rate fees and meter charges. 
l. Insurance premiums. 
m. Bus charters (unless a Purchase Order number is required by the vendor)
n. Miscellaneous fees and assessments (i.e., accreditation, royalty, copyright and appraisals).
o. Fleet Vehicle Rentals
p. Advertising

 Contracted purchases such as Guest Lecturers or Performers & Entertainers must have a completed 
contract routing form and signed contract (per Contract Management Procedures) prior to being paid for 
on a DPV.   DPV’s & Purchase Requisitions containing contract routing forms and contracts should be 
forwarded to the Contract Management Office prior to processing to ensure all documentation adheres to 
current Policy & Procedures. 

Procurement Card, Purchase Requisitions & Purchase Orders 

Items not found on the above list must be purchased using the University Procurement Card or Purchase 
Requisition process.  These orders must be processed following MSU’s Purchasing Manual and 
Procurement Card Program Guide. 

The University Procurement Card (P-Card) can be used to pay for small orders from vendors that accept 
MasterCard. Items that cannot be purchased using the P-Card or DPV must be processed using the 
Purchase Requisition process.  

Orders using the Purchase Requisition process cannot be placed by the end-user, but should be ordered 
by the Purchasing Department via a completed Purchase Order. Note:   Any University employee, who 
makes a contract for supplies, equipment and/or services without a purchase order from the purchasing 
office, may be held personally responsible for clearing the account with the vendor.  

Questions regarding the use of the Direct Payment Voucher should be directed to Business Office (X4107). 

Questions regarding the use of the Procurement Card & Purchase Requisition Process should be directed 
to the Purchasing Office (X4109). 



Step Action Description

1 From the Banner Main Menu, enter FPAREQN into the "GO TO" search box and press "enter"

2 Click on the "NEXT BLOCK" icon.  DO NOT enter a requisition number or the text "NEXT" into this field.

3 Tab to "Delivery Date" field.  DO NOT change "Order Date" or "Transaction Date" fields.

4 Click on the Calendar or manually enter the delivery date.

5a If you have info for the "Comments" field (30 characters max) enter the data and press "enter".

5b Tab to the "Requestor/Delivery/Information section if you don't have data for this field.

A. REQUESTOR/DELIVERY/INFORMATION SECTION

Default information should populate most of the fields in this section.

6 Click on the "Organization" field and enter your home "Org" code, then press "enter".

7 Click the "NEXT BLOCK" icon to go to the "Vendor Information" section or simply click on the tab using your mouse.

**NOTE:  DO NOT change "Ship To" address information.**  Orders purchased using the Purchase Requisition process must be 

delivered and received at the Daniel Bldg Whse (Central Receiving).

B. VENDOR INFORMATION SECTION

**NOTE:  If the vendor is  a company the University has not used before, their information may not be in the Banner 

Database.**

8a
If the vendor is new, a completed & signed W9 is required to set them up.  This will be attached as backup documentation to 

your REQ. 

8b
If the vendor is new, simply type the vendor name in vendor name field and click "NEXT BLOCK" to move to the 

"Commodity/Accounting" Section or simply click on the tab using your mouse.

8c If this is an existing vendor in Banner click on the list button on the "Vendor" field.

9 Select "Entity Name/ID Search" (FTIDEN).

10 To search for an existing vendor, tab to the "Last Name" field.

11 Using % as the wildcard character, enter the vendor's name and press the "F8" key to execute the query.

**NOTE:  Using the % symbol in the beginning of a query request (i.e., %Office) will return results similar to "Texas General Land 

Office".  Using the % symbol at the end of a query request (i.e., Office%) will return results similar to "Office Depot".  You can be 

specific or general with your search criteria depending on how you use your wildcard.  Remember the Banner search feature is 

also case sensitive.**

12
If you wish to redefine your search query "click" on the "Rollback" icon and then the "NEXT BLOCK" icon and repeat steps 10 & 

11.

13a After locating your vendor "Double Click" on that vendor using your mouse.

13b Clicking on the list button on either the "Address Type" or "Sequence" will provide a list of different addresses.

13c Using the scroll bar on the right hand side you can see the different addresses associated with that vendor.

13d
After locating your preferred address "Double Click" on the "Address Type" using your mouse.  This will update your "Vendor 

Information" fields.

14 You can then tab down to the "Contact" or "Email" field to add additional contact information.

**NOTE:  DO NOT add/adjust the "Discount" or "Currency" fields.**

15
To move to the "Commodity/Account" Section click on the "NEXT BLOCK" icon or simply click on the tab using your mouse.

C. COMMODITY/ACCOUNTING SECTION

**NOTE:  Upon arriving in this section you will be assigned your purchase requisition number.  Please write this number down as 

you will need it to attach your backup documentation.**

16 Add your backup documentation to your requisition at this time.  

17 Tab to the "Description" field to enter the description of the first item to be purchased (50 character max).

Appendix 2
Quick Reference Guide (Purchase REQ - Step by Step)

i



Step Action Description

18a

If you are adding additional information for this line item, use your mouse and click on the "Options" tab in the top menu bar 

and select "Item Text".  Multiple lines can be added (50 characters max per line) by using your mouse and clicking on the next 

field.  Remember to save your item text to your requisition.

**NOTE:  Additional text information can also be added to the requisition itself by clicking on the "Options" tab in the top menu 

bar and selecting "Document Text".  Multiple lines can be added (50 characters max per line) by using your mouse and clicking 

on the next field.  Remember to save your document text to your requisition.

18b To navigate back to the Commodity/Accounting section, use your mouse and click on the "X" in the top menu.

19 If you are not adding additional text to the specific line item, tab to the U/M (Unit of Measure) field.

20 Use the list button to get a list of valid "U/M" codes.

21 Enter the "Quantity" of line item (1) you wish to order, then tab to the "Unit Price" field.

22
Enter the "Unit Price" of line item (1) you wish to order, then tab through the "Extended, Discount & Additional" fields to end up 

back at the "Description" field.

**NOTE:  DO NOT enter amounts into the "Discount" or "Additional" fields.  Note the discount for the items in the "Item Text" 

field for that particular line item, then reflect the discount in the adjusted "Unit Price".**

23 Using your mouse, move your curser to the next "Description" field and repeat steps 17 through 22 as necessary.

**NOTE:  If you run out of visible "Description" fields you can use your mouse to click on the "Record" tab in the top menu bar, 

then select "NEXT" for the next empty record.  You can use the "Record" tab to navigate through the different set of records.**

24
When you are finished adding commodity information, click on "NEXT BLOCK" to move the  accounting portion of this section.

25 COA (Chart of Accounts) is always "M".

26
Skip "Index" and enter your "Fund" and "Org" information into their respective fields.  The "Prog" field will default populate.  DO 

NOT change it.

27 Tab to the "Acct" field and enter 7300.  (This will be the Acct Code for all purchase requisitions).

28
Tab to the "Extended" field and enter the amount you wish to be paid from this FOAPAL.  You can pay from multiple FOAPAL's 

but your "Document Accounting Total" must match your "Document Commodity Total".

**NOTE:  Requisitions paying from HEAF & Local Funds must be done on separate requisitions.  Please note in the "Comments" 

field of the "Requestor/Delivery Information" section the corresponding REQ# for each requisition or "1 of 2".  Backup 

documentation should be attached to both requisitions.**

**NOTE:  If you run out of visible "FOAPAL" fields you can use your mouse to click on the "Record" tab in the top menu bar, then 

select "NEXT" for the next empty record.  You can use the "Record" tab to navigate through the different set of records.**

29
To move to the "Balancing/Completion" section, click on the "NEXT BLOCK" icon or simply click on the tab using your mouse.

D BALANCING/COMPLETION SECTION

You can use the "NEXT/PREVIOUS BLOCK" function to navigate back to the "Requestor/Delivery Information" section and double 

check for errors.  You can also use your mouse to click on each tab to navigate through your requisition.

30
If you need to save your requisition you can click on the "In Process" icon at the bottom of this section.  To reacquire your 

incomplete requisition, simply go to FPAREQN and enter your purchase requisition number.

ii



Step Action Description

31 If your requisition is complete and ready to move to the approval process, click on the "Complete" icon.

**NOTE:  If you need to retrieve a completed requisition you can "Deny Document" in "FOADOCU".  This must be done prior to 

the  approval and forwarding of the requisition to the Purchasing Department.**

**NOTE:  To check on the status of a requisition you can go to "FOAAINP" to see where your REQ is in the approval process.**

E ATTACHING BACKUP DOCUMENTATION

1 Using your mouse click on the "BDM - Add Document" icon

2a
After opening your "Application Xtender Web Acccess" screen, click on the "Page Menu"  icon on the document menu bar…

2b then select the "New Page" link…

2c then the "Import File" link…

2d and finally the "Append" link.

3 Locate/highlight the documents you wish to attach to your Banner purchase requisition and click the "open" button.

**NOTE:  Your document should appear in BDM.  If you are adding multiple pages, the last page should be the page visible at 

this point.**

4
Click on the "New" icon button in the application menu to open the indexing function.  The first page of your multiple page 

document should be visible at this point.

**NOTE:  Information should default from your Banner purchase requisition to include the document ID (purchase requisition 

number), Banner Doc Type, Transaction Date, Vendor ID & Name and Activity Date.**

5 Click on the list button in the "Document Type" field and select "Requisition Backup"

6
Click on the "Save" button to save your indexed values assigned to the visible page.  DO NOT CLOSE BDM if you have additional 

pages to add.  Go to step 8.

7
If you are adding a one page document you can log out of AppXtender (BDM) or simply close the "ApplicationXtender" tab in 

Internet Explorer and return to your Banner purchase requisition.

8
If you have additional pages to add "click" on the "Attach All Pages" icon to assign your index values to your remaining pages.

9
At this point you can log out of AppXtender (BDM) or simply close the "ApplicationXtender" tab in Internet Explorer and return 

to your Banner purchase requisition.

10 Click on "BDM - Display Document" icon in INB Banner to double check you have the correct number of pages added.

**NOTE:  The corresponding number of pages should match the number of pages you've added to your REQ.

iii




